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What's New!
Version 1.1x has some exciting enhancements which increase the functionality and 
useability of the Magnification Window.

The Magnification Window now provides Browse buttons, which allow you to easily browse 
through the lists.    The Make Title button allows you to form a new title from text that you 
select in the Clip Item itself.    There is a button to update the Clipboard with any editing 
changes that you may have made to the Clip Item, and there is a help button.    The biggest 
new feature is the Flow Paragraph button.

The Flow-Paragraph button allows you to remove any extra line-breaks or spaces from text 
items, so that they can be easily formatted by your word processor.    It is especially handy 
for text that you get from TEXT files, screen copies of DOS applications, or any text 
Clipboard data.    

As an example, let's say that someone sends you a CompuServe note that you want to 
include in a word processing document.    You can run your communications software in a 
window, and use the mouse to copy the text to the Clipboard.    If you need more than one 
screenfull, you can Concatenate several Clip Items together.    Now you have a Clip Item that 
is all chopped-up with a line-break after each line - not very suitable for your word 
processor!    However, you can use the Flow-Paragraph button to make complete, unbroken 
paragraphs out of the data.    Perfect!

ClipMate's author, Chris Thornton, is now a member of the Association of Shareware 
Professionals (ASP).    



Visual Components of Main Window
Visual Cues:
CipMate incorporates many visual cues and tools to help you find what you're looking for, 
and manage the Clip Items that you have accumulated.    

Depending upon the current Layout that you have selected, you will see some buttons and 
not others.    

Checking and Graying:
In some cases, buttons appearing on the screen will appear to be Grayed or Checked, thus 
assuming the behavior of standard Windows Radio Buttons or Check Boxes.    This is done to 
give you visual cues as to the current state of ClipMate.    

Here are the Visual Components of ClipMate:
(Note: On this help screen, the buttons are "Hot" - you can click on them with the mouse!)

Clip Item Selection List Box

Multiple Selection List Dialog

Delete Button

Concatenate Button

Magnify Button

Copy to Safe Button

Activate Recyclable Button

Activate Safe Button
Config Button

About Button

Note:  For each button, there is both a color version, and a monochrome version.    Since 
ClipMate Help was created using the color versions,    some of the buttons, particularly in the
checked state, will look different than what you see in the on-line help.      



Clip Item Selection List Box

The Clip Item Selection List is used to copy    Clip Items from one of the Clip Item Lists back onto
the Clipboard.    You will accomplish this by simply selecting the title of a stored Clip Item form the 
Clip Item Selection List. 
 
The Clip Item Selection List is a standard Windows Combo Box, which incorporates a static 
text window with a drop-down list.    By clicking the down arrow icon to the right of the text 
window, you will see a scrolling list, by title, of the Clip Items in the active list.    When you 
have made your selection, the list will go away, and the title of the selected Clip Item will 
appear in the text window, and the item is copied to the Clipboard.

Effect on the Magnification Window.
If the Magnification Window is open, then it will also reflect the new selection.    

Keyboard Use:
Alternatively, you can use the up and down arrows on the keyboard to make the selection.    
This sometimes has an advantage, such as when you are browsing the list through the 
magnification window.    It is very easy to sequentially zip through each Clip Item by hitting 
the down-arrow cursor key.    In order to use the cursor key, you must first give input focus to
the list box, or the text window at the top of the list box.    Just click on the text window itself 
with the mouse, and it will appear as reverse video, to indicate that it has the input focus.    
You should learn to use both methods, as they each have advantages.

Rules of Thumb:

1) Whenever either of the Clip Item Lists become active, the top entry of the active list will be 
shown in the text window, and therefore will also be copied to the Clipboard.    This includes the 
initial activation of the Recyclable List, upon startup.

2) Whenever the Clipboard receives a data that can't be represented as text, ClipMate's 
text window will become blank.    This indicates that ClipMate doesn't own the 
contents of the Clipboard, and doesn't know what is in it.    



3) The Clipboard may contain formats other than TEXT.    When multiple formats are 
placed upon the Clipboard, ClipMate makes a copy of the TEXT item, and ignores the 
rest.    If you cause ClipMate to update the Clipboard, the other formats will be lost, as
your Clip Item moves into the Clipboard.    

See: Multiple Selection List Dialog Box



Multiple Selection List Dialog Box

This option consists of a dialog box that allows you to select more than one Clip Item at a 
time, as compared to the Clip Item Selection List Box, which will select only one Clip Item.    
There are several operations that take advantage of the multiple selection, and the 
Concatenate operation requires it.

The Multiple Selection Dialog Box consists of two List Boxes:
The Selection List in on your left.    This is where you make your selections.
The Confirmation List is on your right.    This shows you the order in which you made your

selections.    It is for your reference only, and can't be manipulated.

Here's how to use the Multiple Selection Dialog Box:

1) If you will need to see the Magnification Window, activate it first before opening the 
Multiple Selection Dialog Box.    Use of the Magnification Window is highly 
recommended.

2) Press the MS button to bring up the dialog box.    Once the dialog box is up, you can't 
go back to the rest of ClipMate without pressing either OK or CANCEL.

3) If necessary,    move and or re-size the Magnification Window.    

4) The Selection List appears in the list box on the left.    With the mouse or spacebar, 
select the Titles of the Clip Items that you want to manipulate.    As you make each 
selection, the Clip Item you select is displayed in the Magnification Window.      As the 
Magnification Window only holds one Clip Item at a time, only the most recent 
selection will be shown.    To deselect, simply click again.

5) In the Confirmation List (on the right), your selections will appear in the order that 
you selected them.    This READ ONLY window provides visual confirmation that you 
have selected the items in the order that you intended.    It is especially helpful when 
Concatenating Clip Items, as it gives a "thumbnail sketch" of what you are 
composing.      For the Copy to Safe List operation, the order also comes into play.    
The items will be copied to the Safe List in the order that you selected them, and 
therefore the order that they appear in the Confirmation Window.

6) If you change your mind about a particular item, just click it again.    It will un-hilight, 
and it will disappear from the Confirmation List on the right.    You can select and de-
select as many times as you want.    

7) When you are done with your selections, press OK.    

8) The Delete, Concatenate, and possibly Copy to Safe (depending upon what list is 
currently active) buttons should now be enabled.    You can now perform any of these 
functions using the multiple selection.

Actions that are sensitive to Multiple Selections are:
Delete
Concatenate
Copy to Safe List (only if the Recyclable List is currently active)



Delete

This button is available in both the Full Layout and the Brief Layout.

This operation works with single or Multiple Selections.

Deletes the currently selected Clip Item or Items from the Active List.
The edit box in the Clip Item Selection List Box, as well as the Magnification Window, will be 
blanked out, indicating that ClipMate no longer owns the contents of the Clipboard.    

The contents of the clipboard are unaffected, as ClipMate never deletes the 
contents of the Clipboard.    

For information on selecting Clip Items, 
See: Clip Item Selection List Box

Multiple Selection List Dialog



Edit Title
This option is not available in the Brief Layout. 
However, it may be accessed by the Accelerator key: CTRL+T

The Edit Title dialog box    is accessed under the EDIT menu.    

The Edit Title dialog box allows you to change the Title of a Clip Item.    Although the title is 
initially constructed from the first 50 characters of the Clip Item, changing the title will have 
no effect on the Clip Item.    It is provided for your reference only.    

As an alternative to this dialog box, you can edit the title in the Magnification Window.    



Copy to Safe List

This button is not available in the Brief Layout.

Copies selected Clip Item(s) to the Safe List.          

This operation is only available when the Recyclable List is the Active List.

This operation works with single or Multiple Selections.

For information on selecting Clip Items, 
See: Clip Item Selection List Box

Multiple Selection List Dialog



Concatenate

This button is available in both the Full Layout and the Brief Layout.

Concatenates selected Clip Item(s) into one big Clip Item.    A Clip Item Title is generated that
simply says <<CONCATENATED>>.

This operation only works on Multiple Selection.

The Concatenate operation is very useful in gathering related items together.    Here's an 
example:
Let's say that you need to buy a PC for your office at work.    You sign onto the online 
corporate catalog, and browse around to see what's out there.    Whenever you see 
something that you want, copy it to the clipboard.    When you're done shopping, use the 
Multiple Selection List Dialog to select the components of your new computer system, in 
whatever order you want.    Use the CONCATENATE button to combine your Multiple Selection
into one big Clip Item that you can then paste into the order form, or on-line order screen.    
Painless!

For information on selecting Clip Items, 
See: Multiple Selection List Dialog



Activate Recyclable List

This button is not available in the Brief Layout.

Also accessible from the View Menu.

Causes the Recyclable List to become the Active List.

The Recyclable Button and Safe Button are bound together, and act like radio buttons.    
When you press one, it takes on a Checked appearance, and the clipboard lights up.    The 
other button pops out, and is now ready to be pushed in again.
    
Here's the difference:

The Recyclable List is Inactive:

The Recyclable List is Active:



Activate Safe List

This button is not available in the Brief Layout.

Also accessible from the View Menu.        
Causes the Safe List to become the Active List. 

The Recyclable Button and Safe Button are bound together, and act like    radio buttons.    
When you press one, it takes on a Checked appearance, and the clipboard lights up.    The 
other button pops out, and is now ready to be pushed in again.
    
Here's the difference:

The Save List is Inactive:

The Save List is Active:



Magnify Button

This button is available in both the Full Layout and the Brief Layout.

Also accessible from the View Menu.

Opens, or Closes the Magnification Window.
When the Magnification Window is open, the Magnify Button will appear to be Checked.    In 
this way, it functions like a standard Windows Check Box.    When you press it again, it pops 
up, and the Magnification Window closes.    

Here's the difference between the buttons:

Magnification Window is closed.    You can open it.

Magnification Window is open.    You can close it.



Magnification Window

The Magnification Window displays the Clip Item that is currently selected in the Clip Item 
Selection List Box.    It is used to get a full look at what the Clip Item actually looks like, 
rather than just a glimpse of the title.    Also, you can edit either the Clip Item, or the Title.    
There is a powerful Flow Paragraph function that will reformat the Clip Item into paragraph 
format.      This makes the text more usable by word-processing applications.

To Open the Magnification Window: 
The Magnify Window is opened by either selecting the Magnify option under the View menu, 
or by pressing the Magnify Button.    Upon opening it the button will display its "Depressed" 
state.

To Close the Magnification Window:
The Magnify Window is closed in the same way that it is opened.    Press the Magnify Button, 
and you will see it pop back up from its checked state as the Magnification Window closes.    
Alternately, you can double-click on the control box in the upper-left of the window.

Editing:
You may edit either the text of the Clip Item, or its title.      When you edit the title, it won't 
appear in the Clip Item Selection List immediately.    The Clip Item Selection List will be 
updated when another Clip Item is selected.    Editing the title has the same effect as Edit 
Title.    
 
When you edit the Clip Item, you are affecting the contents of ClipMate's storage, but are 
not directly editing the Clipboard.    The Clipboard will contain the image of the original Clip 
Item, until you cause the Clipboard to be updated.    There are several ways to do this, 
including:

1) Selecting another Clip Item from the Clip Item Selection List 
2) Selecting another Clip Item by Browsing.
3) Pressing the Re-Copy button.
4) Pressing the Flow Paragraph Button.
5) Closing the window.



The Buttons:
Browse Select previous/next Clip Item.
Make Title Creates Title from Selected Text.
Flow Paragraph Re-Flows Paragraph.
Re-Copy Updates Clipboard to reflect your changes.
Help Brings this help topic.
Wrap Text Checkbox Turns word wrap on/off.

Editor Hot Keys:
The following standard Windows Accelerator keys (hot keys) can be used in the Magnification
Window:

Key(s) Function
Backspace Deletes the character to the left of the insertion point.

Or deletes selected text.
Del Deletes the character to the right of the insertion point.

Or deletes selected text.
* Shift+Del CUT - Deletes the selected text and places it on Clipboard.
* Shift+Ins PASTE - Inserts text from Clipboard to the active window.
* Ctrl+Ins COPY - Makes a copy of the selected text and places it on 

Clipboard.
* - Causes Clipboard update, and therefore causes the Magnification Window to 
display whatever you have just copied to or pasted from the clipboard.    To use this 
effectively, see the POWER HINTS below.

Note: The Magnification Window remembers its size, location, and state of the Wrap Text 
Checkbox, even from one session to the next,    by storing them in the ClipMate.INI file.

Power Hints:    
You can copy part or all of the Magnification Window to the Clipboard, and thus back into 
ClipMate by using the accelerator key for copy: Ctrl+Insert.    To do so, just select the text 
that you want to copy, then press Ctrl+Insert.    You are then presented with only the text 
that you have selected.    How is this?    Your new text was Copied to the Clipboard, and so 
ClipMate made itself a copy.    New Clip Items are always made the current selection, as they 
reflect the current Clipboard contents (unless the Safe List is currently active).    

Here's an example of why you would want to use this feature:
Windows Help allows you to copy any given help topic to the Clipboard, but doesn't 
let you select the text that you want - you get the whole topic.    Let's say that there is
a help topic that has an example that you want to include in a document or program 
that you're writing.    From Help, you can Copy the topic to the Clipboard, and from 
within ClipMate's Magnification Window you can do another Copy, on the specific 
chunk that you want.    Try it now on this paragraph!

In fact, I copied the Editor Hot Keys section above from the Editing Keys topic in the 
Program Manager Help. Thanks Microsoft!



Browse Buttons
Available from the Magnification Window.

The Browse Buttons will select the previous/next Clip Item in the Active List. 
The << button moves you toward the top of the list (Newer), and the >> button moves 
toward the bottom of the list (Older).    

As items are selected, they are Copied to the Clipboard automatically.    

If you try to browse past either end of the list, ClipMate will issue a short beep to let you 
know that there is nothing to browse in that direction.

You may have to toggle the Wrap Text Checkbox in order to properly view the Clip Item.



Make Title
Available from the Magnification Window.

The Make Title button will form a new Clip Item Title from selected text.    This is useful for 
when the Clip Item contains a text passage that you want to use as the title.    

To use, just select some text (with your mouse), and then press the button.    ClipMate will 
make a new title out of the selected text, up to the first 50 characters.    The new title is 
immediately reflected in the title box, and the Clip Item Selection List Box



Re-Copy Button
Available from the Magnification Window.

The Re-Copy button is used to update the Clipboard with your changes.    It is only necessary 
if you have manually edited the Clip Item.    When you manually edit the Clip Item, you are 
not directly editing the Clipboard.    Instead, you are editing a local copy within ClipMate.    As
it is impractical for ClipMate to continuously update the Clipboard as you make your 
changes, this button is provided for you to let ClipMate know that you are done editing.    

Other actions such as Browsing, Flow Paragraph, will automatically update the Clipboard as 
part of their action.    Also, re-selecting an item from the Clip Item Selection List Box will 
update the Clipboard.    The final way to update the Clipboard is to close the Magnification 
Window.    



Wrap Text Checkbox
Available from the Magnification Window.

The Wrap Text Checkbox is used to control whether the Magnification Window displays the 
Clip Item in a wrapping edit box, or not.    If the edit box doesn't wrap, then a horizontal scroll
bar is provided.

The setting is retained by the system in the ClipMate.INI.

Performance Note:
When this option is on, it takes the Magnification Windows a little longer to open, and to 
display the Clip Items.    If this becomes a problem, then you should leave this option off, 
except for when you are working with text that is in Paragraph Format.



Flow Paragraph Button
Available from the Magnification Window.

The Flow-Paragraph button re-formats the Clip Item so that it may be easily used by word-
processors.    It removes all of the extra line breaks and spaces that often are embedded 
within text that is copied to the Clipboard.    Here's an example:

If your text looks like this when it gets into your word processor:
    This is some text that was taken 
from dos and
it doesn't fit very well into the 
word processor.  
I would rather let the word processor 
make the important
decisions, such as where the margins should 
go, and whether 
the paragraph should be indented.  I hope I 
don't have to 
manually remove all of that junk! 

You can use the Flow Paragraph button to make it look like this:
This is some text that was taken from dos and it doesn't fit very well into the word 
processor.  I would rather let the word processor make the important decisions, such as 
where the margins should go, and whether the paragraph should be indented.  I hope I don't 
have to manually remove all of that junk! 

The newly formatted text only has line-breaks that define the end of a paragraph, or breaks 
between paragraphs.    Individual lines flow together to form paragraphs.    The word 
processor can then format the paragraph the way that it wants to!

As most applications have their own quirks about how they put text on the Clipboard, 
ClipMate's conversion algorithm is pretty generic at this point.    It should cover most cases - 
if you find a shortcoming, please contact the author, and describe your particular situation 
and applications involved.    Here is a summary of the algorithm that ClipMate currently uses 
to convert paragraphs:

1. Any blanks at the beginning of any line are removed.
2. Any occurrence of multiple blanks is removed, with the following exception: 

Two blanks are allowed to follow a period.
3. Any Line-Break (CRLF) that is not immediately preceded or followed by 

another Line-Break is removed.

 You can convert more than one paragraph at a time, as long as there are at least two line-
breaks between them.    One of these terminates the last sentence of the first paragraph, 
and the other one splits the two.    More line breaks is ok.    If only one line-break is used, 
then the paragraphs will be joined together.

Display:
In order for the newly-formatted text to display properly in the window,    the Wrap Text 
Checkbox is automatically turned on when you press the Re-Flow Paragraph button.    This is 
necessary, as the paragraphs are not broken up with line-breaks, and won't display correctly 
on their own.    Keep this in mind when you are browsing through the Clip Items.    When you 
come accross an item that has been re-formatted this way, you need to check this option.    
Also, Clip Items that aren't formatted this way will look strange when forced to wrap in a 



narrow window.    However, if the window is wide enough, then the text won't get a chance to
wrap anyway.

See: Paragraph Format



Paragraph Format
Definition

Paragraph Format is the way that word processors like to use text.    The word processor likes
to control where the margins are, what type of indenting is used, etc.    Text Clipboard items 
don't fit into that mold very well, as they are usually broken up with line breaks, and may 
have extra spaces.    What may appear to be a paragraph on the Clipboard may turn out to 
be a bunch of lines with linebreaks separating them - to make them LOOK like a paragraph!   
If you paste it into a word processor, you're likely to get something that needs a lot of work.   
You will have to remove the linebreaks yourself, and you may need to remove extra spaces.

The way that the word processor would LIKE to get the data is one long line for each 
paragraph.    There should be no pre-conceptions on how the margins should be, nor any 
hardcoded spaces for indenting.    

Therefore, Paragraph Format is defined as follows:
Textual Clip Items that have an unbroken line for each paragraph of text.    Two or more 
linefeeds in a row signal the start of a new paragraph.

You can use the Flow Paragraph Button to convert plain text to a proper Paragraph Format.



Find
Accessible from the View Menu. 
This option is not available in the Brief Layout, however you can still access it 
with Ctrl+F.

The Find command will prompt you for some text to search for, and then search the Active 
List for the first ClipMate's of the specified text.    It is NOT case sensitive.

If the string is found, the corresponding Clip Item is selected, and displayed in the edit 
window of the Clip Item Selection List Box.    If not, then you will ClipMate's a notification 
message, and the edit window will be blank.

If the Magnification Window is active, then it will also reflect results of the search, in the 
same way that the edit window of the Clip Item Selection List Box does

See: Find Next



Find Next
Accessible from the View Menu.        

This option is not available in the Brief Layout, however you can still access it 
with Ctrl+N.

The Find Next search the Active List for the next ClipMate's of the text that was found by 
FIND.

If the text is found, the corresponding Clip Item is selected, and displayed in the edit window
of the Clip Item Selection List Box.    If the text is not found, you will ClipMate's a notification 
message, and the edit window will be blank.

If the Magnification Window is active, then it will also reflect results of the search, in the 
same way that the edit window of the Clip Item Selection List Box does



Overview
If you are new to ClipMate, please read entire section.

ClipMate (TM) is designed to enhance the operation of the native Clipboard capability of 
Windows.    From a functional standpoint, the Windows Clipboard works exactly as it should: 
allowing the user to transfer an item of data within an application, or between applications.   
In practice, however, the Clipboard falls short in that it only can hold one item of data at a 
time.    Multiple formats yes, but still the same item of data.    Once you perform a CUT or 
PASTE, the contents of the Clipboard are emptied, and your new piece of data is now the 
sole occupant of the clipboard.    There is no ability to append new data onto the existing 
clipboard data, no UNDO capability, and no long-term memory.    That's where ClipMate steps
in!

ClipMate adds several enhancements to the operation of the Windows Clipboard.    It allows 
you to keep many generations of previous Clipboard occupants, (Clip Items) for later 
retrieval.    If there is a particular piece of data that you use often, it can be stored 
indefinitely in ClipMate's SAFE list.    You can even concatenate multiple clip items into one 
piece of data for pasting into an application.    

Here's how ClipMate operates:
ClipMate sits idle most of the time, waiting for any activity in the Windows Clipboard.    
Whenever you put anything on the Clipboard (by CUTting or COPYing), ClipMate gets a 
message from Windows.    ClipMate checks to see if the Clipboard is holding an acceptable 
format (TEXT is the only format currently supported).    If ClipMate can use the data on the 
Clipboard, it PASTEs the data into itself, and dynamically allocates storage for it.    It places 
the new data in one of its lists, creates a title from the first 50 characters in the text, and 
displays the title in the text window at the top of the Clip Item Selection List Box.    If the 
Magnification Window  is active, the new Clip Item is displayed within. 

Access to the clipboard data is easily obtained through the use of a drop-down list.    Upon 
making your selection, ClipMate automatically copies the item to the clipboard.    It is then 
ready for your use in any application that offers clipboard support for text.

See: Clip Items
Clip Item Lists
Visual Components  
Layout
Magnification Window

ClipMate Index



Glossary



Checked
Some of ClipMate's buttons act like Radio Buttons or Check Boxes in order to convey 
information about the button, and the underlying state of ClipMate.    For example, when the 
Magnification Window is open, its button is shown in the Checked state, indicating that the 
Magnification Window is already open.    As this button acts like a Check Box, you can press it
again to toggle the state, and therefore close the window. 

Here are the corresponding button states of this example:

In Color:

UnChecked:

Checked:

In MonoChrome:

UnChecked:

Checked:



Grayed
Some of ClipMate's buttons can be Grayed, to show that they are not eligible to be chosen.    
This is usually because a prerequisite for the corresponding function has not been fulfilled.    
For example, if there is no Clip Item currently selected, then you can't possible Delete a Clip 
Item.    Therefore, both the Delete button, and the Delete option from the Edit Menu are 
Grayed.

Here is an example of a Grayed button:

In Color:

Grayed:

In MonoChrome:

Grayed:



Radio Button
Standard Windows Radio Button, also known as Option Button.
Allows you to choose one or the other, but not both.    Selecting one will deselect the other.



Check Box
Standard Windows Check Box.
Allows you to toggle the state of a setting within the application.    It is either on, or off.



Clipboard
The Windows clipboard acts as a repository for data in a variety of formats.    Applications 
can place data into the Clipboard, through Copying or Cutting.    Applications can retrieve 
data from the Clipboard by Pasting.    

In actuality, there is no Clipboard program.    At least in the sense that you could point to a 
particular program, and declare it to be the clipboard.    The Clipboard Utility that comes with
Windows is not the Clipboard, it is just a utility that can be used to display or delete the 
contents of the Clipboard.    It does not have to be open, or even on your hard disk in order 
to perform Clipboard functions.    In real terms, the Windows Clipboard is set of Windows 
functions that programs use to share data.

The Clipboard can be used to hold a variety of formats, usually simultaneously.    The most 
common format, and the only one currently supported by ClipMate is the text format.    Other
common formats are Bitmap, Symbolic Link, TIFF, etc.

This definition is partly based upon the definition of the Clipboard in Tom Swan's Turbo 
Pascal for Windows 3.0 Programming.



Layout - Full Layout vs Brief Layout.
ClipMate gives you the option of displaying all of its graphical controls, along with the Menu 
(Full Layout), or just showing a some of the graphical controls, with no Menu (Brief Layout).    

Why would you want to do that?    

Sometimes, you don't need the full functionality of ClipMate, and would gladly trade some 
functionality for valuable screen space.    This is especially true when you are using the 
"Keep Window On Top" option, found in the Config dialog box.    Thus, the Brief View was 
created to fill this need.    

The Brief View gives you the Delete, Concatenate and Magnify buttons, 
along with the Config, Multi Select, and About buttons.

How To Change Layouts:
The layout is selected in the Config dialog box, which is accessed from either the Config 
Menu (in full layout), or the CFG Button (in the brief layout).    Make your choice in    the box 
titled: "Full Layout (See All Controls?)".    Select OK to close the window.    

In this version of ClipMate, the layout can't be redefined "on the fly".    You will need to exit 
ClipMate, and re-start, in order to see the new layout.    The layout will be in effect 
indefinitely, until you switch layouts again (if ever).

Limitations of Brief Layout:
Unless you switch between the Recyclable List and the Safe List a lot, you probably won't 
miss the Full Layout.        All Menu options are also absent, but you have buttons that will 
access the Config dialog box, and the About box.    From the About box, you can also access 
the on-line Help system.    Unless you want to work with different files, you won't be needing 
anything under the FILE menu either.  Find and Find Next can be accessed by their 
Accelerator Keys, Ctrl+F, and Ctrl+N, respectively.    



Config - Configuration Dialog Box
Accessible from the Config pull-down menu (when ClipMate is in the Full Layout) or the CFG 
Button    (when ClipMate is in the Brief Layout).    

The Config Dialog Box lets you change various ClipMate settings.    They are stored in the 
ClipMate.INI file, for later retrieval.    

Automatically Save Current File When Shutting Down?
When you close ClipMate, a check is made to see if the current file needs saving.    If 
so, then this value is checked to see whether you want to Always Save.    If so, then 
ClipMate just saves the file, and you aren't bothered with confirmation.    Otherwise, 
ClipMate will ask you whether or not you wish to save the file.    
Default: Always Save 

Where to Put New Clipboard Items?
When ClipMate detects that there is a new Clip Item to retrieve from the Clipboard, it 
must decide which list should ClipMate's it.    If the Recyclable List is currently active, 
then the new item will always go there.    If the Safe List is active, then it checks this 
value, and places the item accordingly.    This is useful in order to keep from cluttering
up your Safe List with trivial items, if you happen to have the Safe List active.    On 
the other hand, you may want to turn on Current Active List, if you want to collect 
some items that you want to keep for a long time.
Default: Recyclable List

Length of Recyclable List:
This allows you to control the length of the Recyclable List.        ClipMate will 
accumulate Clip Items in the Recyclable List, and allow the list to grow until this limit 
is reached. 
When the list is at its limit, an old item will drop off from the bottom for every new 
item added to the top.    

Trade-Off:
Increasing this value will cause ClipMate to keep more Clip Items, but the trade-off is 
that it will use more memory.

Default: 25

Max Size for Clip Item:
This is a truncation threshold for NEW Clip Items in terms of bytes of storage.    If the 
size of a new Clip Item exceeds this limit, then the Clip Item is truncated.    This is 
useful in the event that you copy a large chunk of text, perhaps an entire document 
in your word processor.    It prevents ClipMate from capturing and storing the entire 
item, and saves both time and memory.    If you want to be able to capture larger 
items (or lower the threshold), just adjust this number.    It cannot exceed the system 
limit of 16384, and shouldn't be set lower than 1024.    

This value only affects new Clip Items, and doesn't affect Concatenated Clip Items.

Trade-Off:
Increasing this value will allow ClipMate to capture larger items, but      it will use more
memory.

Default: 4096



Keep Window on Top?
This allows you to force ClipMate to "float" to the top of all other windows.    It is 
especially helpful when you have a lot of windows open, or if you are using an 
application that is running full-screen, such as a word processor.    
If you find that the Full Layout takes up too much of your screen space, try the Brief 
Layout.    
If it still takes up too much screen space, try minimizing it to an icon, which will also 
"float" on the screen.    You can position the icon anywhere that you want,    even in 
the same place that you want the ClipMate window to occupy.

Trade-Off:
It will probably float above your screen saver.
If ClipMate and another application are both trying to stay on top, they may spend a 
lot of your CPU time bickering with each other, and will create an annoying 
"flickering" effect.    However, it is easy to turn on and off.

Default: unchecked (no)

Full Layout?
ClipMate gives you the option of displaying all of its graphical controls, along with the
Menu (Full Layout), or just showing a some of the graphical controls, with no Menu 
(Brief Layout).    Here is where you make that choice.
For a full explanation, see Layout.

Trade-Off:
When in Brief Layout, not all features are accessible.    In particular, you lose the 
ability to switch back and forth between the Recyclable List  and the Safe List.    In the
Full Layout, you have access to all features, but ClipMate will take up more screen 
space.    

Default: Full Layout



About 

Accessible from the Help - About pull-down menu (when ClipMate is in the Full Layout) or the
? Button    (when ClipMate is in the Brief Layout).    

In addition to displaying the "normal" about information, this Dialog Box gives you the 
opportunity to register ClipMate, and access the on-line help.    The HELP button is provided 
in order to give access to HELP when ClipMate is in the Brief Layout. 

Help Info:
Number of Clip Items: Total of both Recyclable and Safe Lists.
Memory Used.... Total memory used by both lists.
Registered To: Hopefully You!



Clip Item Title
A Clip Item will have a Clip Item Title, which is initially constructed from the first 50 
characters of the clip item.    You can edit this title in the Magnification Window, or by 
selecting Edit Title from the EDIT menu.    During a Concatenation, the title is assigned to: 
<<Concatenated>>.

See: Clip Items
Magnification Window
Edit Title



Clip Items
When any application places text on the Clipboard, ClipMate makes a copy for itself.    This 
copy of the clipboard contents is considered to be a Clip Item, and is stored in a Clip Item 
List. 

A Clip Item will have a Clip Item Title, that is initially constructed from the first 50 characters
of the clip item.    You may edit this title in the Magnification Window, or by selecting Edit 
Title from the EDIT menu.

Clip Items are dynamically sized upon creation.    They will typically consume a byte of 
memory for each character in the text, plus 50 characters for the title, and a few extra bytes
to keep track of everything.

You can edit the Clip Item in the Magnification Window.    

New Clip Items will be placed on one of the Clip Item Lists.    depending upon which list is the
Active List, and the option chosen in the Config screen.    

See: Clip Item Lists
Magnification Window
Edit Title
Config 



Clip Item Lists
Clip Items are stored in Clip Item Lists as they are pasted from the Clipboard.    ClipMate 
supports two Clip Item Lists:

Recyclable List: Maintains a user-defined number of Clip Items.    New Clip Items are 
at the top of the list, and work their way down as still newer items 
are added.    When the number of Clip Items in the list exceeds the 
user-specified limit, clip items are deleted from the list, thus freeing
up space in the system.    Since the space is re-usable, the list is 
known as the Recyclable List.

Safe List: Stores as many Clip Items as you would ever want to keep.    Like 
the Recyclable List, new Clip Items enter at the top of the list, and 
work their way down as still newer items are added.    But YOU are 
responsible for deleting obsolete clip items.    This is a handy way to
keep track of "Boiler-Plate" items, such as letter templates, return-
addresses, or even often-used chunks of code, if you happen to be 
a programmer.

New Clip Items will be placed on one of the Clip Item Lists.    depending upon which list is the
Active List, and the option chosen in the Config screen.    

See: Copy to Safe List
Config
Clip Items



Active List
Whichever of the two Clip_Item_Lists is currently shown in the Clip Item Selection List Box is 
the Active List.    Its corresponding button will appear to be checked.    The button 
representing the other list will be sticking up, ready to be pushed.    



Edit Menu
The Edit Menu allows you to manually alter the contents of either of the two lists.
Most commands are available on the Icon Bar.    

Menus are not available in the Brief Layout.

For more information, select the Edit menu command name.

Edit Title Changes the title of a Clip Item.
Delete Item Remove Clip Item from active list
Copy to Safe List Puts a copy of the selected Clip Item on the Safe List.
Concatenate Concatenates clip items together.



View Menu
The View Menu allow you to change the Active List, open or close the Magnification Window, 
or perform word searches with the Find or Find Next commands..    

Menus are not available in the Brief Layout.

For more information, select the Edit menu command name.

Activate Recyclable List
Activate Safe List
Magnify
Find
Find Next



File Menu
Menus are not available in the Brief Layout.

The File menu includes commands that enable you to open and save ClipMate files.

New - Clears storage, creates a new file.
Open - Opens existing file.
Save - Saves current file.
SaveAs - Saves with new name.
Exit - Ends ClipMate

For the most part, it will not be necessary for you to ever choose any of these.    ClipMate will
automatically open DEFAULT.CLM when it starts, or a file that you specify on the command 
line (of the icon that launches ClipMate).        Upon closing, ClipMate will attempt to save both
of the Clip Item Lists into the current file    Depending upon the option that you have selected
in the CONFIG screen, you may be prompted before the file is saved.    Therefore, if you 
always use DEFAULT.CLM,    you will never need to use the FILE menu.    



Exiting
Use File Exit, or Double-Click on the control box (in the upper left hand corner) in the main 
window.

If Always Save is checked in the Config screen, then the current file (usually Default.Clm) 
will automatically be saved.    Otherwise, you will be prompted to save changes, if either list 
has been added to or modified in any way.    

The ClipMate.INI file in the Windows directory will be updated upon exiting from ClipMate.    



SHAREWARE
DEFINITION OF SHAREWARE - Provided by the Association of Shareware Professionals (ASP)

Shareware distribution gives users a chance to try software before buying it. If you try a 
Shareware program and continue using it, you are expected to register. Individual programs 
differ on details -- some request registration while others require it, some specify a 
maximum trial period. With registration, you get anything from the simple right to continue 
using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder 
retains all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality. (In both cases, there are good programs and bad ones!) The main 
difference is in the method of distribution. The author specifically grants the right to copy 
and distribute the software, either to all and sundry or to a specific group. For example, 
some authors require written permission before a commercial disk vendor may copy their 
Shareware.

Shareware is a distribution method, not a type of software. You should find software that 
suits your needs and pocketbook, whether it's commercial or Shareware. The Shareware 
system makes fitting your needs easier, because you can try before you buy.    And because 
the overhead is low, prices are low also. Shareware has the ultimate money-back guarantee 
-- if you don't use the product, you don't pay for it.

ClipMate is a "shareware program" and is provided at no charge to the user for evaluation.    
Feel free to share it with your friends, but please do not give it away altered or as part of 
another system.    The essence of "user-supported" software is to provide personal computer 
users with quality software without high prices, and yet to provide incentive for 
programmers to continue to develop new products.    If you find this program useful and find 
that you are using ClipMate and continue to use ClipMate after a reasonable trial period (30 
days), you must make a registration payment of $20.00 to the author. 

Site License arrangements may be made by contacting the author .

Anyone distributing ClipMate for any kind of remuneration must first contact the author for 
authorization.    This authorization will be automatically granted to distributors recognized by
the Association of Shareware Professionals (ASP) as adhering to its guidelines for shareware 
distributors, and such distributors may begin offering ClipMate immediately (However the 
author must still be advised so that the distributor can be kept up-to-date with the latest 
version of ClipMate).

You are encouraged to pass a copy of ClipMate along to your friends for evaluation.    Please 
encourage them to register their copy if they find that they can use it.    No one may 
distribute a partial or altered copy of ClipMate.    As the registration information is stored in 
the ClipMate.INI file, this file MUST NOT BE DISTRIBUTED.    If you are uncertain whether you 
have a complete package, see: DISTRIBUTION FILES to ensure that all of the required files 
are present.    If you don't have a complete copy, you should obtain another copy from a 
reliable source, such as CompuServe, or contact the author directly.

This definition of Shareware is based upon a shareware definition that was provided by the 
Association of Software Professionals, and was originally prepared by Paul Mayer, author of 
GRAB Plus.    It resides in the ASP forum on Compuserve as: SHAREW.PRN.

See: Registering ClipMate



Disclaimer

ASP
OMBUDSMN



ASP - Association of Shareware Professionals

What is the ASP?
The ASP is an association for shareware authors with the general goals of educating 
shareware authors and distributors and the public, setting standards, sharing resources and 
information among members.

Who is the ASP?
Membership is open to programmers who are authors of at least one "nontrivial" product 
which is currently marketed and supported as shareware, who agree to abide by standards 
adopted by the association, and whose membership, in the judgment of the Membership 
Committee, will not be detrimental to the goals or reputation of the ASP.
Also, Associate Membership is open to Vendors and Bulletin Board operators.

See: OMBUDSMN



OMBUDSMN - Required Statement

This program is produced by a member of the Association of Shareware Professionals (ASP).   
ASP wants to make sure that the shareware principle works for you. If you are unable to 
resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for members' 
products.    Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442 or 
send a CompuServe message via CompuServe Mail to ASP Ombudsman 70007,3536. 

Author's Note:
All ASP authors are required to reproduce this statement.    It is here for YOUR protection, in 
the event that you are unable to resolve a problem with an ASP author, or if you are trying to
contact an ASP author that has re-located.    



Disclaimer
DISCLAIMER - AGREEMENT

Users of ClipMate must accept this disclaimer of warranty:    "ClipMate is supplied as is.    The 
author disclaims all warranties, expressed or implied, including, without limitation, the 
warranties of merchantability and of fitness for any purpose.    The author assumes no 
liability for damages, direct or consequential, which may result from the use of ClipMate ."

This disclaimer was provided by the Association of Software Professionals, and was originally
prepared by Paul Mayer, author of GRAB Plus.    It resides in the ASP forum on Compuserve 
as: SHAREW.PRN.

See: Registering ClipMate



Registering ClipMate
How Much?
The registration fee for ClipMate is $20.00 in U.S. funds.    

What Does it Get You?
By registering ClipMate, you gain several things:

A new diskette - I will send you the latest and greatest release of ClipMate, on you choice
of either a 720k 3.5" (the default), or 360k 5.25" diskette.      

A registration number - which will remove the annoying "SHAREWARE NOTICE" reminder 
screens    from all 1.x versions of ClipMate. 

Peace of mind - you have fulfilled your obligation, and have made the Shareware concept
work.    You are not breaking the law, at least in this particular case!

Access to support - If you have problems using ClipMate, either from a user or technical 
perspective, I am there to help you.    You can reach me by US mail, or by my 
CompuServ mailbox (70743,2546).    Support is guaranteed for 90 days from the date 
of registration.    If I can't resolve your problem to our mutual satisfaction, I will refund
your money, as long as the problem is brought to my attention within the 90 day 
window.

How To Register?
One of the ClipMate distribution files is CLMREG.TXT.    This is the preferred method of 
registering ClipMate.    I recommend that you edit it electronically, print it, and mail it to me.

If you lack a form, no problem.    Just send me a letter (and a check or money order), and 
include the following:

Full Name of Purchaser
Mailing Address
Where did you get ClipMate?    

If other than "FRIEND", please specify (e.g. CompuServ)
What version do you have (See Help - About)

Please send payment to:
Chris Thornton
PO Box 26263
Rochester, NY    14626

Foreign Registrations?
If you are out of the U.S., and can't get a check drawn on a U.S. Bank, then try a postal 
money order.    Under no conditions should you send me a check drawn on a non-U.S. bank.    
It would likely cost me between $10 and $25 to get it cashed!



Distribution Files
The following files are provided with ClipMate, and constitute a complete ClipMate package:

CLIPMATE.EXE The executable program - requires Windows 3.x
CLIPMATE.HLP Help file.
CLMICONS.DLL Dynamic Link Library to support the icon ribbon.
CLMREAD.TXT README file with any special considerations or installation notes.
CLMREG.TXT Registration form.    
CLMVEND.DOC Vendor Description for Shareware vendor or BBS Sysop.

DO NOT DISTRIBUTE THE ClipMate.INI FILE!



Installation Notes
To install ClipMate, just copy all of the Distribution Files to the directory of your
choice.    It doesn't need to be in the path, and there are no funny environment
variables to set.    My recommendation is to create a directory: \windows\
ClipMate, and put the files there.

Create an icon in the program manager with a Command Line that points to 
ClipMate.    
For example:
C:\windows\ClipMate\ClipMate.exe

If you wish to use a filename for your data, other than DEFAULT.CLM, you can 
specify your filename as a parameter to ClipMate.    In this case the Command 
Line in the Program Manager would be:    
C:\windows\ClipMate\ClipMate.exe myfile.clm
You should note, however, that the LOAD= statement of the Win.Ini doesn't 
allow parameter to applications.    To use the LOAD= or RUN= statement, you 
would have to set up an association (see the File Manager) of .CLM files to 
ClipMate.EXE, and then put the name of your data file in the LOAD= or RUN= 
statement.    It works out to be easier just to let ClipMate default to 
DEFAULT.CLM for most purposes.

The first time that you run ClipMate, it will create \windows\ClipMate.ini.    
WIN.INI is not altered in any way, nor are any of your other system files.    
For more information, see ClipMate.INI.

ClipMate will save the clipboard data into DEFAULT.CLM, or another .CLM file 
that you specify.    

See Distribution Files for a list of all of the files that are provided with the 
ClipMate package.

System Requirements:
ClipMate requires a VGA or better display (monchrome vga is ok).
It will run in Real mode, but Standard is preferred, Enhanced 
mode is best.

Bug Reports:
Please send any bug reports, along with a description of your
system (hardware and software) to CompuServ id: 70743,2546 or 

Chris Thornton
PO Box 26263
Rochester, NY    14626

Known Problems:
Norton Desktop for Windows and Turbo Pascal for Windows have a 
compatibility problem.    Until Borland and Symantec hash this out, ClipMate 
won't run under Norton Desktop.    
See the CLMREAD.TXT file for more information on this, including an interim 
workaround.



ClipMate.INI
The ClipMate.INI file holds various settings and preferences.    It is used in lieu of WIN.INI, as 
this is considered to be proper programming practice these days.    It relieves the system of 
having to load a lot of garbage into memory, and makes it easy to remove an application.

The ClipMate.INI file is saved every time that ClipMate is shut down, whether or not a 
change has actually taken place.    It has nothing to do with the ASK User vs Always Save 
option.

Here are the default settings for ClipMate.INI:
[ClipMate]
AlwaysSave=1
AskUser=0
RecyclableList=1
ActiveList=0
KeepOnTop=0
MaxView=1
RecyclableLength=25
MaxClipSize=4096
X=0
Y=0
magX=100
magY=100
magW=200
magH=400
WrapCheck=0
Registered Name=Not Registered
Registered Number=

Additional Settings:
There are some additional settings that are not configurable within ClipMate, but will be 
used by ClipMate if they are present in this file.    I normal situations, they would not be 
needed.    They are provided in the event that someone has a problem that could be 
remedied by adjusting one of these settings:
HeapLimit=4096 ; Heap Threshold
TimerTick=1000 :Timer Limit, in milliseconds, for Keep On Top.




